Sparsity of targeted proteins in NIST database
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Supplementary Figure 1. Poor coverage of target transcription factor proteins in NIST
database

A histogram of the number peptide MS/MS spectra in the NIST database per target protein
demonstrates how underrepresented transcription factors are from current peptide spectral
libraries. A majority of our target proteins have no MS/MS spectra in the NIST spectrum library.
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Supplementary Figure 2. In vitro-synthesized proteins are enriched full-length proteins
(a-b) Glutathione-enriched protein samples from 46 of the 96 reactions were run on a denaturing
SDS-PAGE gel and subjected to either western blotting with an anti-schistosomal GST antibody (a)
or silverstaining (b). The endogenous glutathione-binding proteins EEF1G and GSTM3 were
identified using ‘shotgun’ mass spectrometry. The molecular weight of the full length cDNA is
indicated in parentheses. These weights do not include the 26kDa GST tag.



Calibration curve for the
GST peptide IEAIPQIDK
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Supplementary Figure 3. Calibration curve for the schistosomal GST peptide IEAIPQIDK

A dilution curve of the unlabeled schistosomal GST peptide IEAIPQIDK peptide standard was spiked
with a constant amount of the heavy labeled IEAIPQIDK peptide. The unlabeled to labeled peak
area was measured by LC-SRM-MS for each standard in triplicate.
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Supplementary Figure 4. Histogram of dot-products for quality score 1 and 2 peptides
Dot-products were calculated using Skyline and the 2011_05_26 NIST release of the H. sapiens lon
Trap peptide spectral library.



e - ESPPredictor Rank vs.
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S . . for STAT5A (rho=0.55)
S5 Ny 3
090 n | I .
CE' o o © 5__ * *
%) _S — ] * .
W s ! 2103 * . .
Y— (] ! a ] .‘
o = X ] .
c 2 ' T ¢ .
o o ! ) ] * *
= @© : ! c 3 *
-E; "t'u' o o — 20—_ . *
o ©° © 1 . ¢ .
E® c 25 * .
g e °© D ] . .
5. 0] .
€ e S 4 © = E . *
g o 1 o 35 . .
g s v 1% *
8-.§ lel|llIl]lIiT|lI[llIllT[llllllIll}Tll[
w W oW NN =2 g
(&) (== S o (9] o
o .
< ESPPredictor rank

Supplementary Figure 5. Spearman correlation of our empirical peptide ranking with
ESPPredictor rankings

(a) Box-and-whisker plot showing the distribution of spearman correlations for the 75 proteins
with both ESPPredictor scores and empirical SRM peptide signal intensities. The spearman
correlation of these 2 rankings for each protein ranged from -0.45 to 0.85 with an average
correlation of 0.47. (b) A representative comparison of our empirical signal intensity rank for the
STAT5A peptides and the ESPPredictor score rank for the same peptides. This comparison shows a
better than average correlation (rho = 0.55 versus an average of rho = 0.47).
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Supplementary Figure 6. Peptide MS/MS spectrum counts are a poor predictor of targeted
peptide signal intensity using selected reaction monitoring-mass spectrometry

(a-b) The NFKB1 (a) and NR5A1 (b) samples were subjected to ‘shotgun’ analysis using data-
dependent acquisition. For each peptide, the number of +2 charge state spectra identified in this
‘shotgun’ run is indicated above the SRM signal intensity of that peptide.



Units used per Cost per 96
Item Manufacturer Product# | Cost perunit | 96 reactions reactions
Human In Vitro Protein Expression Kit - DNA (50
reactions) Pierce 88855 $515 2 $1,030.00
Glutathione Sepharose 4B (10mL) GE 17-0756-01 5242 0.2 $48.40
PPS Silent Surfactant (5x1 mg vials) Protein Discovery 21011 $199 1 $199.00
Oasis® MCX plate 30mg/60 pm 1/pkg Waters 186000250 5326 1 $326.00
Sequencing Grade Madified Trypsin (100pg) Promega V5111 $80 0.4 $32.00
Lab reagents Various Various $150 1 $150.00
Total: $1,785.40
Cost per reaction: $18.60

Supplementary Figure 7. Reagent cost for generating in vitro-synthesized proteins from

plasmids

The reagent usage is based on our current working protocol (Methods). The prices used in this
calculation are based on manufacture posted prices on May 24t 2011.




SUPPLEMENTARY DATA LEGENDS

Supplementary Data 1. Rank order of proteotypic peptides and fragment ions for targeted
proteins

(Pages 9-10) Proteins targeted in this dataset. Columns: Gene Symbol, Gene Description, DNA-
binding domain family, mRNA Accession, DNASU Plasmid Repository Clone ID, Page number for
targeted data.

(Pages 11-35) For each protein monitored in this dataset, the summed peak intensity for each
peptide, as well as the relative contribution of each fragment ion to this signal is displayed. Quality
score 1 peptides are labeled in green, quality score 2 peptides are labeled in yellow, quality score 3
peptides are labeled in purple, and quality score 4 peptides are labeled in red.



Proteins Targeted

Gene Symbol Description DNA-binding domain family Accession DNASU Clone ID Page
ATF4 activating transcription factor 4 (tax-responsive enhancer element B67) basic-leucine zipper (bZIP) CR456384 HsCD00301229 pg. 12
ATOH7 atonal homolog 7 (Drosophila) basic helix-loop-helix (bHLH) BC032621 HsCD00077283 pg. 12
BATF basic leucine zipper transcription factor, ATF-like basic-leucine zipper (bZIP) NM_006399 HsCD00301458 pg. 12
BHLHB2 basic helix-loop-helix domain containing, class B, 2 basic helix-loop-helix (bHLH) BC082238 HsCD00299716 pg. 12
CCDC16 coiled-coil domain containing 16 zinc finger, C2H2-type (C2H2) BC011584 HsCD00078107 pg. 13
CEBPG CCAAT/enhancer binding protein (C/EBP), gamma basic-leucine zipper (bZIP) BC007582 HsCD00077759 pg. 13
CLOCK clock homolog (mouse) basic helix-loop-helix (bHLH) BC041878 HsCD00299832 pg. 13
CREB1 cAMP responsive element binding protein 1 basic-leucine zipper (bZIP) BC010636 HsCD00077213 pg. 13
CTCF CCCTC-binding factor (zinc finger protein) zinc finger, C2H2-type (C2H2) BC014267 HsCD00078657 pg. 14
DMRT1 doublesex and mab-3 related transcription factor 1 DM DNA-binding domain (DM) BC040847 HsCD00300076 pg. 14
DMRTC2 DMRT-like family C2 DM DNA-binding domain (DM) BC029202 HsCD00299763 pg. 14
E2F5 E2F transcription factor 5, p130-binding TF E2F/dimerisation partner (TDP) NM_001951 HsCD00302966 pg. 14
ERG v-ets erythroblastosis virus E26 oncogene like (avian) ETS-domain (ETS) BC040168 HsCD00299791 pg. 15
ETS2 v-ets erythroblastosis virus E26 oncogene homolog 2 (avian) ETS-domain (ETS) NM_005239 HsCD00301527 pg. 15
ETV3 ets variant gene 3 ETS-domain (ETS) BC022868 HsCD00077713 pg. 15
EWSR1 Ewing sarcoma breakpoint region 1 ETS-domain (ETS) CR456490 HsCD00301321 pg. 15
EZH2 enhancer of zeste homolog 2 (Drosophila) SANT-domain (SANT) BC010858 HsCD00077678 pg. 16
FEV FEV (ETS oncogene family) ETS-domain (ETS) BC023511 HsCD00079089 pg. 16
FOSB FBJ murine osteosarcoma viral oncogene homolog B basic-leucine zipper (bZIP) NM_006732 HsCD00301650 pg. 16
FOSL2 FOS-like antigen 2 basic-leucine zipper (bZIP) BC022791 HsCD00079102 pg. 16
FOXDA4L1 forkhead box D4 like 1 Forkhead-domain (Forkhead) NM_012184 HsCD00302896 pg. 17
FOXD4L2 FOXD4-like 2 Forkhead-domain (Forkhead) BC103887 HsCD00299718 pg. 17
FOXN1 forkhead box N1 Forkhead-domain (Forkhead) NM_003593 HsCD00302766 pg. 17
FOXR2 forkhead box R2 Forkhead-domain (Forkhead) BC012934 HsCD00301098 pg. 17
GATA2 GATA binding protein 2 zinc finger, GATA-type (ZNF-GATA)  BC002557 HsCD00077154 pg. 18
GATA3 GATA binding protein 3 zinc finger, GATA-type (ZNF-GATA) BC006793.1 HsCD00305430 pg. 18
GFI1 growth factor independent 1 zinc finger, C2H2-type (C2H2) BC032751 HsCD00079248 pg. 18
GMEB1 glucocorticoid modulatory element binding protein 1 SAND-domain (SAND) BC001473 HsCD00299674 pg. 18
GMEB2 glucocorticoid modulatory element binding protein 2 SAND-domain (SAND) BC036305 HsCD00299890 pg. 19
GTF2H4 general transcription factor IIH, polypeptide 4, 52kDa Other BC004935 HsCD00079304 pg. 19
H1FO0 H1 histone family, member 0 Other CR456502 HsCD00301329 pg. 19
HMGA1 high mobility group AT-hook 1 high mobility group-type (HMG) NM_002131 HsCD00301489 pg. 19
HMGB2 high-mobility group box 2 high mobility group-type (HMG) BC001063 HsCD00078150 pg. 20
HOXA10 homeobox A10 Homeodomain (Homeodomain) BC013971 HsCD00078539 pg. 20
HOXAS5 homeobox A5 Homeodomain (Homeodomain) NM_019102 HsCD00304202 pg. 20
HSF4 heat shock transcription factor 4 Heat-shock factor (Heat Shock) NM_001538 HsCD00302758 pg. 20
HSFY2 heat shock transcription factor, Y linked 2 Heat-shock factor (Heat Shock) NM_153716 HsCD00302426 pg. 21
D2 inhibitor of DNA binding 2, dominant negative helix-loop-helix protein helix-loop-helix (HLH) D13891 HsCD00301602 pg. 21
ID3 inhibitor of DNA binding 3, dominant negative helix-loop-helix protein helix-loop-helix (HLH) BC003107 HsCD00078304 pg. 21
IRF1 interferon regulatory factor 1 Interferon regulatory factor (IRF) BC009483 HsCD00077440 pg. 21
IRF3 interferon regulatory factor 3 Interferon regulatory factor (IRF) BC009395 HsCD00079105 pg. 22
IRF4 interferon regulatory factor 4 Interferon regulatory factor (IRF) BC015752 HsCD00077553 pg. 22
IRF5 interferon regulatory factor 5 Interferon regulatory factor (IRF) BC004139 HsCD00078081 pg. 22
LEF1 lymphoid enhancer-binding factor 1 high mobility group-type (HMG) BC050632 HsCD00299770 pg. 22
LHX4 LIM homeobox 4 Homeodomain (Homeodomain) BC011759 HsCD00077458 pg. 23
LIN28 lin-28 homolog (C. elegans) zinc finger, C2HC-type (C2HC) BC028566 HsCD00079059 pg. 23

MAD MAX dimerization protein 1 basic helix-loop-helix leucine zipper L06895 HsCD00301580
(bHLHZ) pg. 23

MAX MYC associated factor X basic helix-loop-helix leucine zipper NM_002382 HsCD00301600
(bHLHZ) pg. 23

MEF2A MADS box transcription enhancer factor 2, polypeptide A (myocyte enhancer MADs-box (MADs-box) BC013437 HsCD00299868
factor 2A) pg. 24

MEF2C MADS box transcription enhancer factor 2, polypeptide C (myocyte enhancer MADs-box (MADs-box) BC026341 HsCD00300012
factor 2C) pg. 24
MYB v-myb myeloblastosis viral oncogene homolog (avian) SANT-domain (SANT) AF104863 HsCD00301531 pg. 24
MYBL2 v-myb myeloblastosis viral oncogene homolog (avian)-like 2 SANT-domain (SANT) BC007585 HsCD00077770 pg. 24

MYC v-myc myelocytomatosis viral oncogene homolog (avian) basic helix-loop-helix leucine zipper BC000141 HsCD00076570
(bHLHZ) pg. 25
MYF6 myogenic factor 6 (herculin) basic helix-loop-helix (bHLH) BC017834 HsCD00077638 pg. 25
NFATC3 nuclear factor of activated T-cells, cytoplasmic, calcineurin-dependent 3 Cell surface receptor (IPT/TIG) BC001050 HsCD00077145 pg. 25
NFE2 nuclear factor (erythroid-derived 2), 45kDa basic-leucine zipper (bZIP) BC005044 HsCD00079103 pg. 25
NFIA nuclear factor I/A nuclear factor I-domain (NFI) BC022264 HsCD00077446 pg. 26
NFIC nuclear factor I/C (CCAAT-binding transcription factor) nuclear factor I-domain (NFI) BC012120 HsCD00078641 pg. 26
NFKB1 nuclear factor of kappa light polypeptide gene enhancer in B-cells 1 (p105) Cell surface receptor (IPT/TIG) BC051765 HsCD00301116 pg. 26
NR113 nuclear receptor subfamily 1, group |, member 3 Nuclear hormone receptor (NHR) BC069626.1 HsCD00304068 pg. 27
NR2E1 nuclear receptor subfamily 2, group E, member 1 Nuclear hormone receptor (NHR) NM_003269 HsCD00305417 pg. 27
NR3C1 nuclear receptor subfamily 3, group C, member 1 (glucocorticoid receptor) Nuclear hormone receptor (NHR) BC015610 HsCD00300083 pg. 27
NR5A1 nuclear receptor subfamily 5, group A, member 1 Nuclear hormone receptor (NHR) BC032501 HsCD00299843 pg. 27
OLIG1 oligodendrocyte transcription factor 1 basic helix-loop-helix (bHLH) BC033290 HsCD00076967 pg. 28
OTX1 orthodenticle homolog 1 (Drosophila) Homeodomain (Homeodomain) BC007621 HsCD00077740 pg. 28
PATZ1 POZ (BTB) and AT hook containing zinc finger 1 zinc finger, C2H2-type (C2H2) CR456613 HsCD00301150 pg. 28
PITX3 paired-like homeodomain transcription factor 3 Homeodomain (Homeodomain) BC011642 HsCD00078535 pg. 28
PLEK2 pleckstrin 2 Other BC001226 HsCD00077265 pg. 29
POLR2F polymerase (RNA) Il (DNA directed) polypeptide F Other CR456546 HsCD00301192 pg. 29
POU1F1 POU domain, class 1, transcription factor 1 (Pit1, growth hormone factor 1) POU-domain (POU) NM_000306 HsCD00302903 pg. 29
POU3F4 POU domain, class 3, transcription factor 4 POU-domain (POU) NM_000307 HsCD00303140 pg. 29
POU4F1 POU domain, class 4, transcription factor 1 POU-domain (POU) NM_006237 HsCD00302919 pg. 30
POU4F3 POU class 4 homeobox 3 POU-domain (POU) BC104923 HsCD00300001 pg. 30
PPARA peroxisome proliferator-activated receptor alpha Nuclear hormone receptor (NHR) CR456547 HsCD00304173 pg. 30
SF3A2 splicing factor 3a, subunit 2, 66kDa zinc finger, C2H2-type (C2H2) BC004434 HsCD00079081 pg. 30
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Gene Symbol Description Accession DNASU Clone ID Page
SOX10 SRY (sex determining region Y)-box 10 high mobility group-type (HMG) CR456584 HsCD00301364 pg. 31
SOX5 SRY (sex determining region Y)-box 5 high mobility group-type (HMG) NM_006940 HsCD00301463 pg. 31

SREBF2 sterol regulatory element binding transcription factor 2 basic helix-loop-helix leucine zipper ~ CT841522 HsCD00301198
(bHLHZ) pg. 31

STAT5A signal transducer and activator of transcription 5A Signal Transducers and Activators of BC027036 HsCD00076786
Transcription subdomain (STAT) pg. 32

STAT5B signal transducer and activator of transcription 5B Signal Transducers and Activators of BC065227 HsCD00299823
Transcription subdomain (STAT) pg. 32

TAF11 TAF11 RNA polymerase Il, TATA box binding protein (TBP)-associated factor, Other NM_005643 HsCD00301672
28kDa pg. 32
TEF thyrotrophic embryonic factor basic-leucine zipper (bZIP) NM_003216 HsCD00304220 pg. 33
TFAP2A transcription factor AP-2 alpha (activating enhancer binding protein 2 alpha) Transcription factor AP-2 (AP2) BC017754 HsCD00077076 pg. 33
TFAP2B transcription factor AP-2 beta (activating enhancer binding protein 2 beta) Transcription factor AP-2 (AP2) BC037225 HsCD00076757 pg. 33
TFCP2L1 transcription factor CP2-like 1 CP?2 transcription factor (CP2) BC064698 HsCD00299737 pg. 33
TFCP2L4 transcription factor CP2-like 4 CP2 transcription factor (CP2) BC036890 HsCD00299801 pg. 34
TFDP2 transcription factor Dp-2 (E2F dimerization partner 2) TF E2F/dimerisation partner (TDP) BC021113 HsCD00299708 pg. 34
TGIF2 TGFB-induced factor 2 (TALE family homeobox) Homeodomain (Homeodomain) BC012816 HsCD00079074 pg. 34
TP53 tumor protein p53 (Li-Fraumeni syndrome) p53-like DNA-binding (p53) BC003596 HsCD00078349 pg. 34
TP73L tumor protein p73-like p53-like DNA-binding (p53) BC039815 HsCD00299815 pg. 35
XBP1 X-box binding protein 1 basic-leucine zipper (bZIP) CR456611 HsCD00301204 pg. 35
ZMAT5 zinc finger, matrin type 5 zinc finger, C2H2-type (C2H2) CR456353 HsCD00301319 pg. 35
ZNF496 zinc finger protein 496 zinc finger, C2H2-type (C2H2) BC007263 HsCD00077733 pg. 35
ZNF530 zinc finger protein 530 zinc finger, C2H2-type (C2H2) BC060865 HsCD00301131 pg. 36
ZNF70 zinc finger protein 70 (Cos17) zinc finger, C2H2-type (C2H2) CR456615 HsCD00301373 pg. 36
ZNF74 zinc finger protein 74 zinc finger, C2H2-type (C2H2) CR456616 HsCD00301379 pg. 36

Table Legend

Peptide Quality
Score
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SUPPLEMENTARY DATA LEGENDS

Supplementary Data 2. Comparison of our empirical rankings with peptide rank predictions
from the ESPPredictor algorithm
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SUPPLEMENTARY NOTE: TUTORIAL

Skyline Absolute Quantification

Introduction

This tutorial covers how to determine the absolute abundance of a target protein using Selected
Reaction Monitoring (SRM) mass spectrometry. Specifically, we will demonstrate how to use an external
calibration curve with an internal standard heavy labeled peptide.

Peptide absolute abundance measurements can be obtained using either a single-point or a multiple-
point calibration. Single-point calibration absolute abundance measurements are generated by spiking
into a target sample a heavy labeled ‘standard’ version of the target peptide that is of known
abundance. The absolute abundance of the ‘sample’ target peptide is obtained by calculating the
relative abundance of the light ‘sample’ target peptide to the heavy ‘standard’ target peptide®’. One
drawback is that this approach assumes that a light-to-heavy ratio of 2 implies that the light peptide is
actually twice as abundant as the heavy peptide — this is referred to as having a peptide response with a
slope of 1. Furthermore, this approach of using a single point calibration makes the assumption that
both the light and the heavy peptide are both within the linear range of the mass spectrometry
detector. However, these assumptions are not always correct®***>>%,

Multiple-point calibration experiments correct for situations where the peptide response does not have
a slope of 1. This calibration is done by measuring the signal intensity of a ‘standard’ peptide at multiple
calibration points of known abundance and generating a calibration curve. This calibration curve can
then be used to calculate the concentration of the target peptide in a sample, given the signal intensity
of that peptide in that sample®*. One drawback is that this method requires multiple injections into the
mass spectrometer to build a calibration curve.

To improve the precision of absolute abundance measurements using an external calibration curve,
stable isotope labeled internal standards are often used”’. Imprecise measurements of the ion intensity
of a peptide often arise from sample preparation, autosampler or chromatographic irregularities. By
adding an identical quantity of a standard heavy labeled peptide to each of the calibrants and the
sample, one is able to measure the ratio of calibrant-to-standard or sample-to-standard. This approach
is favored as this ratio is unaffected by some sample preparation, autosampler or chromatographic
irregularities. Consequently, by performing peptide absolute quantification using an external calibration
curve and an internal standard heavy labeled peptide one is able to obtain the most accurate and
precise measurements while minimizing the amount of valuable sample that has to be used.
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Experimental Overview

This tutorial will work with data published in Stergachis et al. 2011 where the absolute abundance of
GST-tagged proteins were measured using a ‘proteotypic’ peptide present within the GST-tag (Tutorial
Figure 1A). For any absolute quantification experiment, it is critical to first identify one or more
‘proteotypic’ peptides that will be used to quantify the protein of interest. The peptide IEAIPQIDK was
identified as ‘proteotypic’ based on its strong signal intensity relative to other tryptic peptides in the
GST-tag (unpublished). Also, this peptide uniquely identifies this schistosomal GST-tag as opposed to
other human glutathione-binding proteins.

For this experiment, FOXN1 protein containing an in frame GST-tag was generated using in vitro
transcription/translation and full-length proteins were purified using glutathione resin (Tutorial Figure
1B). Heavy labeled IEAIPQIDK peptide was then spiked into the elution buffer and the sample was
digested and analyzed using selected reaction monitoring (SRM) on a Thermo TSQ Vantage triple-
quadrupole mass spectrometer. An external calibration curve was generated using different quantities
of a light IEAIPQIDK peptide that was purified to >97% purity and the concentration determined by
amino acid analysis. Heavy labeled IEAIPQIDK peptide was also spiked into these calibrants at the same
concentration as in the FOXN1-GST sample (Tutorial Figure 1C). It is important to note that it does not
matter what the concentration of the heavy peptide is in each of the samples, so long as it is the same.
However, it is best if the amount of heavy peptide in the samples is similar to the amount of light
peptide originating from FOXN1-GST. Also, it is best if the concentration of the light peptide originating
from FOXN1-GST falls somewhere in the middle of the concentration range tested using the different
calibrants.
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A C

GST-tag protein sequence
PILGYWKIKGLVQPTRLLLEYLEEKYEEHLYER
DEGDEKWRNEKFELGLEFPNLPYYIDGDVELTQS

Light IEAIPQIDK Heavy IEAIPQIDK
Sample peptide’ peptide*

MAIIRYIADKHNMLGGCPKERAEISMLEGAVLD Standard 1 40 fmole/pl 5 fmole/pl
IRYGVSRIAYSKDFETLKVDFLSKLPEMLKMFE
DRLCHKTYLNGDHVTHPDFMLYDALDVVLYMDP
MCLDAFPKLVCFKKRIEAIPQIDKYLKSSKYIA Standard 2 U 12.5 fmole/pl 5 fmole/pl
WPLQGWQATFGGGDHPPKSDLVPR
Standard 3 U 5 fmole/pl 5 fmole/pl
FOXN1 cDNA Standard 4 U 2.5 fmole/pl 5 fmole/ul
PANT7_cGST vector
Standard 5 1 fmole/ul 5 fmole/pl
in vitro
* e vonansiaton Standard 6 U 0.5 fmole/j 5 fmole/pl
Purify full-length G5T-tagged
* protein using glutathione resin Standard 7 U 0.25 fmole/ul 5 fmole/pl
Elute in 100ul volume with Heavy
labeled IEAIPQIDK peptide spiked in Standard 8 0.1 fmole/pul 5 fmole/pl
* Digest protein sample with trypsin
FOXN1-GST
@ Unknown 5 fmole/ul

Monitor Light and Heavy labeled ivtt reaction
IEAIPQIDK peptide using SRM

* Light standard peptide is purified to >97% purity and the

Quantify GST-tagged protein using concentration was determined by amino acid analysis (AAA)

Light:Heavy ratio of IEAIPQIDK peptide
and external calibration curve ¥ Heavy peptide is “C, "N, L-Lysine labeled crude peptide and the
concentration was determined by absorbance at A280

Tutorial Figure 1. Experimental Overview

(A) Schistosomal GST-tag protein sequence. The tryptic peptide used for quantification purposes is
indicated in red.

(B) Schematic of the synthesis, enrichment, digestion and analysis of tagged proteins.

(C) Samples monitored and the abundance of light and heavy IEAIPQIDK peptide in each.

Getting Started
First, please check
(https://skyline.gs.washington.edu/labkey/wiki/home/software/Skyline/page.view?name=tutorials) to

ensure that this tutorial is up-to-date. Periodic revisions of this tutorial will occur as additional features
are added to Skyline.

To start this tutorial, download the following ZIP file:

https://skyline.gs.washington.edu/tutorials/AbsoluteQuant.zip

Extract the files in it to a folder on your computer, like:
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C:\Users\absterga\Documents
This will create a new folder:
C:\Users\absterga\Documents\AbsoluteQuant

Now start Skyline, and you will be presented with a new empty document.

Generating a Transition List

Before you insert a peptide sequence into Skyline, it is important to make sure that all of the peptide
and transition settings are correctly configured for this experiment. The settings described below are
designed for *C¢"°N, L-Lysine labeled internal standard peptides. If you are using a different isotope,
please choose the appropriate isotope modification in the Peptide settings configuration.

Configuring Transition settings:

e On Settings menu, click Transition Settings.

e  Click the Prediction tab.

e Choose Monoisotopic for the Precursor mass and the Product ion mass.

e From the Collision energy drop-list choose the instrument that you will be using for your
measurements. For this experiment, a Thermo TSQ Vantage was used for all measurements.

e Click the Filter tab.

e For these experiments we monitored doubly charged precursors (Precursor charges), and singly
charged (lon charges) ys to y,; product ions (lon types and Product lons From and To).

o The correct configuration of these tabs can be seen below.

N
Transition Settings I ﬂ Transition Settings I ﬂ
Prackdion ,Fi‘w ‘ ]h S [FdScan| ‘F — | == wa | I |
Precursor mass: Product ion mass: Precursor charges: lon charges: lontypes
Monoisotopic - | Monoaisotopic: - 2 1 y
s Product ions
Collision energy: Declustering potential: 1
Themo T5Q Verieg ~ [Nore = 1 From: To:
ion 3 =] [lstion-1 -
(7] Use optimization values when present
Aways add:
[] N4eminal to Proline I[ Edi List.. l

[] Cteminal to Glu or Asp

Precursor m/z exclusion window:
Th

[¥] Auto-select 2l matching transttions
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Configuring Peptide settings:

On the Settings menu, click Peptide Settings.

Click the Modifications tab.

Click the Edit list button for Isotope modifications.

Click the Add button.

Choose Label:13C(6)15N(2) (C-term K) from the Name dropdown list.

Click the OK button.

Check the new Label:13C(6)15N(2) (C-term K) modification in the Isotope modifications list.
Since the experiment uses a heavy labeled internal standard peptide, ensure that the Internal
standard type drop-list is set to heavy.

Peptide Settings &= ]

Digestion | Prediction | Fiter | Library | Modications | =y e o |

Structural

(V] Carbamidomethyl Cysteine Edit list...

-13C(8) R
Label 13C(6)15NEZ) (Ctem K)
Label: 13C(5)15N(4) (Ctem R)
Label: 13C15N

Label 15N

Label: 180(1) (Cem)

Label 180(2) (Cem)

Monoisolopic mass:

(e =)

| Digestion | Prediction | Fiter | Library | Modfications |

@1 @158 [[Jwo [CO2H

Monoisolopic mass: Average mass.
[eo14189

Relative retention time:

Sinuctural modfications:
(7] Camamidometid Cystene Ednist...

(7547847
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Inserting a peptide sequence:
e On the Edit menu, choose Insert and click Peptides.
e Paste IEAIPQIDK into the Peptide Sequence box and GST-tag into the Protein Name box.
e Click the Insert button.

Peptide Sequence Protein Mame
IEAIPQIDK GST4ag

CheckforEmors | [ nset | [ Cancel |

After performing the above steps, the main screen of Skyline should appear as below. You can save this
file as test_file or whatever you like in the folder you have created for this tutorial.

File Edit View Settings Help

DEH BRI -™-
ER N GST4ag
-2 |EAIPQIDK
2- A, 51379514+
i L AT-784.4563+
e JL 1B]- 7134192+
A P [y5]-600.3352+
- Q [y4]-503.2824+
o i 13- 3752238+
=] _,L 517.8022++ theavy)
L AT- 792.4705+
o 18- 7214334+
U P [y5] - 608.3494+
i Qbv4l-511.2966+
- AL 131 383.2380+

1/1 prot 1/1 pep 1/2 prec 1/10 tran .:

Exporting a transition list:
e  On the File menu, choose Export and click Transition List.
o The Export Transition List form can be configured as desired. Below is what was used for this
experiment
e This exported transition list was used to generate an SRM method for a Thermo TSQ Vantage
triple-quadrupole mass spectrometer.
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Export Transition List

|
Instrument type:

Themo 57

@ Single method

() One method per protein

) Multiple methods - : |

Max transitions per sample injection:

Methods: 1
Optimizing:
Method type:

Analyzing SRM Data from Calibrants

In this next section you will work with the nine samples indicated in Tutorial Figure 1C. You will import
the .RAW files into Skyline to view the data. Data will be imported into the saved Skyline document that
was generated in the previous section. The files that you will import are contained in the folder you
created for this tutorial and are called:

e Standard_1.RAW
e Standard_2.RAW
e Standard_3.RAW
e Standard_4.RAW
e Standard_5.RAW
e Standard_6.RAW
e Standard_7.RAW
e Standard_8.RAW
e FOXN1-GST.RAW

These RAW files were collected in a random order and were interspersed amongst a larger set of runs
contained within Supplemental Data 2 for the original paper
(http://proteome.gs.washington.edu/software/skyline/ivt_srm/Supplementary_data_2.zip).

Before you look at the FOXN1-GST sample, you should first become familiar with the standards.

Importing RAW files into Skyline:
e On the File menu, choose Import and click Results.
e C(lick the Add single-injection replicates in files option in the Import Results form.
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e Click the OK button.

e Inthe Import Results Files form, find and select all eight Standard RAW files listed above.

e C(Click Open to import the files.

o  When presented with the option to remove the ‘Standard_’ prefix in creating replicate names,
click Do not remove.

It may take a few moments for Skyline to import all of the RAW files.

Lookin: [3)Raw Files

- 1hi FOXN1-GST.RAW
@ Add single-injection replicates in files

) Add multisnjection replicates in directories

) Add one new replicate

Sourcename:  “Standard_1.RAW" “Standard_2.RAW" “Standard_3 RAW
Sources of type: [ Any spectra fomat ~| [ Cancel |

To ensure that the chromatographic peaks for each of the standards looks good, it is best to view all of
the traces next to each other in a tiled view.

This can be done by clicking ctrl-T or on the View menu, by choosing Arrange Graphs and clicking Tiled.

If you select the IEAIPQIDK peptide on the left side of the screen, you will see the heavy (Blue) and light
(Red) traces loaded into the same window for each standard.

pn sty e
File  Edit View Semings Help
O Hd @ 9-0-
Beplicates: Standard 1 = Standard_1 1 -x Standard_2 I~ Standard_3 1l -x Standard 4 11 -x
% S35 \EAPGIDK —— IEAIPQIDK - 51378517+ —— IEAIPQIDK- 5137951+ —— IEAIPGIDK - 513 7951++ i —— IEAIPQIDK - 513 7951+
o ': v'.ﬂ. 513,756 10 botal 0 21.45) — EAIPQIDK - 5178022+ (heavy) —— IEAIPQIDK - 517 8022+ (heavy) m— IEAIPQIDK - 517 8022+ (eavy) 200 —— IEAIPQIDK - 517 8022+« (heavy)
- @ _j 5170022+« heovy) B 209 5 3_22 15 226 & s
H > &4 | | g FA g o>
= 10 £ | =10 i =
z . 23t ! z | z wo
g5 | 5 f i fez2\ § 05 £ 200
£ M £ L2\ z £
= 10 =i = 00 = gl
206 208 210 212 218 220 222 224 226 222 224 226 228 230 208 210 212 214 216
Retention Time Retention Time Retention Time Retention Time
Standard 5 1l »X | Sunderd 6 11 »X | Sunderd7 11 »X | Standerd 1%
—— [EAIPQIDK - 513.7951++ —— IEAIPGIDK - 513.7851+= —— IEAIPGIDK - 513.7951+~ —— IEAIPQIDK - 513.7951+
—— IEAIFQIDK - 517.8022++ {hea: = IEAIFQIDK - 5178032+~ (heavy) —— IEAIPQIDK - 5178022+~ (heavy} —— IEAIFQIDK - 517.8022++ heavy)
7 600 201 7 208 ﬁsuo 213 ‘-(,,-m 209
s ™ S 600 L s i | S Lo
= i = = 400 T 400
z £ a0 | i = =
w w i i ® i w
£ £ 20 I S04 | g 200 By 1, | i
E - P 5 W :, Ll £,
195 200 205 204 206 208 210 212 210 215 205 210 215
. . i Retention Time Retention Time Retention Time Retention Time
Ready ) ) 171 prot 111 pep 172 pree 110ten

What to inspect when looking at the chromatographic traces for the standards:
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e Make sure that the correct peak is selected for both the heavy and light trace of each standard.

e Make sure the peak shapes look Gaussian and do not show an excessively jagged appearance. If
this is the case, it may be best to rerun your samples.

e Make sure that the retention time is similar for the different standards. Widely varying retention
times often indicate poor chromatography.

Analyzing SRM Data from FOXN1-GST Sample

Next you will want to import the FOXN1-GST.RAW file into the current Skyline document using the same
instructions as detailed above. To ensure that this sample looks good, we will inspect the
chromatographic trace, the fragmentation pattern and the retention time of both the heavy and light
peak.

Because this is already a refined method, on the Settings menu, click Integrate All.

To focus on just the FOXN1-GST data, on the View menu, choose Arrange and click Tabbed (Ctrl-Shift-T),
and click on the FOXN1-GST tab.

The Retention Time comparison graph can be displayed by pressing F8 or on the View menu, by
choosing Retention Times and then clicking Replicate Comparison.

The Peak Areas comparison graph can be displayed by pressing F7 or on View menu, by choosing Peak
Areas and then clicking Replicate Comparison.

To view the relative contribution of each transition to the total signal intensity, you can right-click on the
Peak Areas graph, choose Normalized To and click Total.
1 Skyline - AbsoluteQuant sky (=0 o~ |

File Edit View Settings Help
DEH @ 9-

Replicates: FOXNL-GST - Peak Areas 11 =X Retention Times 1l =X d3 | Standard 2 | Standard 1 FOXN1-GST 41| ¥ X
= % GSTtag 200 —
= @ 9 IEAPQIDK W 7 - 7544563 me y5-7134102+ W 77644563 = y6-7134102%
R W 513 7551 ++ fotal ratio 0.71) — 5 - 600.3352- mmmm y4-503.2824+ w5 - 600.3352+ mmmm y4-503.2824+
- @ 517.8022+ heavy) 3 - 3752738~ w3 - 375.2238+
235 T 209
L
230 150 |
2st [l
@
o
3 e 220+ IIIII o
g E A
g Eoasi =
: E m g
@
: B | W :
< e £
= = 2054 =
3
* 200 % IIH
20 1+
195 4+
19.0 t t
T T T T T - = o ~ =
B P B g B BB OE W E E T = <} 212
5 5 5 ¥ Oy g 5 5 Q
£ £ 5 3 5 8 B o3 Z H 5 5 H z 0 e
s BE B W@ 8O L ® L B 2 204 206 208 210 212
v Replicate Replicate Retention Time
Ready 1/1 prot 171 pep 1/2 prec 1/10 tran
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1u Skyline - AbsoluteQuant.sky o[ )
File Edit View Settings Help

DEH & 2@ 9-

Replicates: FOMNI1-GST - Peak Areas ) [ 23

Retention Times 11 » X rd3  Standard_2  Standardl FOXNI-GST 41 ¥ X
=%, GST4ag 250 —
=22 9 IEAIPQIDK 7 - 792 4705+ WM G- 7214334 7 - 7924705+ wmmm yG-7214334« ”
- @ 513.7951++ fotal ratio 0.71) — 5 - 60834094+ w4 - 5112066+ — 5 - 608.3494+ g4 - 5112966« :F 9
RN 517 5022+ heavy) — 3 - 3832380+ m— 3 - 383.2380+

235

200 +
230 +

2st |l
2ot I

215

o gy i mu'""llﬂﬂﬂl]

205

200 | i

150 +

Measured Time
Intensity (1043)

100 +

Peak Area Percentage

195 & 50 4
19.0 + t t + t t t t +
L e
P F E R R R EOE G E E R E R R R E G
£ E E T OEOEO:EOE oz g 8 8B g E 2 O OE oz 0 e S—p—
v » v B B B B & O & B B B B B B B o y ) y i .
b < 204 206 208 210 212
< — . Replicate Replicate Retention Time
Ready 171 prot. 1/1 pep 2/2 prec 6/10 tran

You can then select either the light or heavy precursor and inspect to ensure that:

e The correct peak is selected for both the heavy and light trace.

e The peak shape looks Gaussian and does not show an excessively jagged appearance.

e The retention time is similar for the standards and the FOXN1-GST sample.

e The relative contribution of each transition to the total signal is similar for each sample. If this
does not appear to be so, then an incorrect peak is likely selected for one of the samples.

Another way to view the data is to select the IEAIPQIDK peptide in the Peptide View to the left, as
opposed to the individual light and heavy precursor ions.

To view the light-to-heavy ratio for each standard and the FOXN1-GST sample, you can right-click on the
Peak Areas graph, choose Normalized To and click Heavy.

The values displayed in this Peak Areas graph will be the ones we use to build our calibration curve. It
can be easily observed from this graph that the light-to-heavy ratio for the FOXN1-GST sample falls
somewhere in the middle of the ratios from our calibration points. This is ideal, as this portion of the
calibration curve is best for quantification purposes.
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1 Skyline - AbsoluteQuant sky
File Edit View Settings Help
DEE & @9~
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Generating a Calibration Curve

For this tutorial, you will make a calibration curve using Microsoft Excel. However, this can be done

using other graphical or statistical programs such as R.

Exporting data from Skyline:
On the File menu, choose Export and click Report.

=

Click Edit List and then Add to specify the columns that will appear in the report.

For this experiment you will want to have identifying features for each sample, as well as the

RatioToStandard (See below for the parameters included).

Once the report is configured, you can provide a Report Name.

1u Edit Report

Report Name: Peptide Ratio Results

(= Peptides
[#)- Precursors
[=]- Peptide Results
- Peptide Peak FoundRatio
- PeptideRetention Time
RatioToStandard
-BestReplicate
Sequence
BeginPos
EndPos
PredictedRetention Time
AverageMeasuredRetention Time
Note
(- Results
ProteinName
ProteinDescription
ProteinSequence
ProteinNote

Peptide Sequence
ProteinName

Rﬂ plicateName
Ratio ToStandard

»

[] Pivot Replicate Name
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e Click OK.

e C(lick OK in the Edit Reports form.

e C(Click Export in the Export Report form.

e Enter ‘Calibration.csv’ in the File name field of the save form that appears.
e Click Save.

When opened in Excel, the exported report should look like this:

@' =, = Calibration_2.csv - Microsoft Excel — = 52
Home Insert Page Layout Formulas Data Review View 0 o @ 8
Al - Jf< | PeptideSequence N |
[ A B C D Ev
! 1 IPeétideSeéuence_lDroteinName ReplicateName RatioToStandard
: 2 |IEAIPQIDK GST-tag Standard_1 21.4513
3 IEAIPQIDK GS5T-tag Standard_2 6.2568
4 |IEAIPQIDK GST-tag Standard_3 2.0417
| 5 IEAIPQIDK GST-tag Standard_4 0.8244
| 6 |IEAIPQIDK GST-tag Standard_5 0.2809
| 7 IEAIPQIDK GST-tag Standard_6 0.1156
| 8 |IEAIPQIDK GST-tag Standard_7 0.0819
| 9 [IEAIPQIDK GST-tag Standard_8 0.0248
| 10 IEAIPQIDK GST-tag FOXN1-GST 0.7079
11 v
[ < » ¥ calibration_2 /%3 M4 [ |
| Ready | ||EE| E 100% (=) () +) .

To generate a calibration curve, you first need to specify for each standard the concentration of the light
IEAIPQIDK peptide. These values can be found in Tutorial Figure 1C and are also displayed below.

Once these known concentrations are entered, you can display the calibration curve by selecting the
values, as indicated below, and clicking the Insert tab and then Scatter Plot.

A trendline for the calibration curve can be generated by right-clicking on the data points within the
graph and selecting Add Trendline. From the trendline options, you will want to select Linear
Regression. In more recent versions of Excel, you will also want to make sure the check boxes are
checked to display the equation and the R-squared value on the chart.

Now inspect the trendline to ensure that:

e None of the standards drastically depart from it.
e The data points still appear to follow the trendline even at the lower concentration points.
e The R*value is high, indicating a good fit.
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IE“ H9--|s Calibration.csv - Microsoft Excel o B 2
Home Insert Page Layout Formulas Data Review View @ e o g R

D2 M - Je | 214513 [
A B C D E | B
1 PeptideSequence ProteinName ReplicateName RatioToSt: Concentration (fmol/ul) [
2 |IEAIPQIDK GST-tag Standard_1 21.4513 40|
| 3 |IEAIPQIDK GST-tag Standard_2 6.2568 12.5
| 4 |IEAIPQIDK GST-tag Standard_3 2.0417 5
5 |IEAIPQIDK GST-tag Standard_4 0.8244 20
_6 |IEAIPQIDK GST-tag Standard_5 0.2809 1
7 |IEAIPQIDK GST-tag Standard_6 0.1156 0.5
| 8 |IEAIPQIDK GST-tag Standard_7 0.0819 0.25
| 9 |IEAIPQIDK GST-tag Standard_8 0.0248 0.1
10 IEAIPQIDK GST-tag FOXN1-GST 0.7079
11
12 " .
13 Calibration Curve
14 as 3
15 0 y=18477x+05537 1
16 R‘:'oﬁsy'
17 =35
=
= 330
1| £
20 e 25
2
22 H
815
23 € /
8
24 10

w
4

NN
<o
o

28 0 5 10 15 20 25
29 Light-to-Heavy Ratio 7l
30

31 k-
i < » | calibration %3 KR! w | L0
Ready | Average: 58079625  Count:16 Sum: 929274 |[EH|D M 100% (=) {} {x) .

Calculating the Concentration of the FOXN1-GST Sample

To calculate the concentration of the light IEAIPQIDK peptide within the FOXN1-GST sample you will use

the calibration curve from the previous section. This will allow you to calibrate the light-to-heavy ratio of
IEAIPQIDK within the FOXN1-GST sample to known concentrations. To do this, you must first identify the
slope and intercept of the calibration curve.

To do this, you can select two adjacent cells in Excel and type into the equation dialog:
=LINEST(E2:E9,D2:D9)

E2:E9 are the y-values (Concentration)
D2:D9 are the x-values (light-to-heavy ratio)

Then press ctrl-shift-Enter and the Slope and Intercept will be displayed in the two selected cells
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lE\ H9-0~|= Calibration.csv - Microsoft Excel o B =
m Home Insert Page Layout Formulas Data Review View Y @ o @ 2
SUM v (© ® « f<| =LINEST(E2:E9,D2:D9 v
A B c [ D E =
1 PeptideSequence ProteinName ReplicateName RatioToSt: Concentration (fmol/ul) ]
2 IEAIPQIDK GST-tag Standard_1 21.4513 40
3 IEAIPQIDK GST-tag Standard_2 6.2568, 12.5
4 |EAIPQIDK GST-tag Standard_3 2.0417 L
5 IEAIPQIDK GST-tag Standard_4 0.8244. 2.5
6 |IEAIPQIDK GST-tag Standard_5 0.2809 : |
7 |IEAIPQIDK GST-tag Standard_6 0.1156 0.5
8 IEAIPQIDK GST-tag Standard_7 0.0819 0.25
9 IEAIPQIDK GST-tag Standard_8 0.0248 0.1
10 IEAIPQIDK GST-tag FOXN1-GST 0.7079
1|
12 B
13 Calibration Curve
14 45
15 - y=1.8477x+0.5537
16 R‘zo.ggy' =
17 _.35
=
& 2w
1| &
20 e 25
I =
22 =
n|| i o
8
24 10 /
= 5
26 /
27| L
28 0 5 10 15 20 25
29 Light-to-Heavy Ratio
30|
31 Slope (m Intercept (b)
22 =LINEST(E2:E9,D2:09 =
33 [ LINEST(known_y's, [known_x's], [const], [stats]) ] =
M 4 » ¥ calibration /%3 [l m » 1]
Point | | B8 0 B 100% S —

Using this linear equation the concentration of any unknown sample (y-value) can be obtained by
inserting the light-to-heavy ratio of that sample (x-value) into a standard y = m*x + b equation
(concentration = slope * ratio + intercept).

We can do this for the FOXN1-GST sample in excel by typing into a cell:
=B32*D10 + C32

B32 is the slope of the linear regression
D10 is the light-to-heavy ratio of the FOXN1-GST sample
C32 is the Intercept of the linear regression



IE“ H9- o= Calibration.csv - Microsoft Excel o B =
Home Insert Page Layout Formulas Data Review View @ e o @ =R
SUM ML - X v ﬁr_ =B32*D10+(C32 e
A B c D | E | F T
1 PeptideSequence ProteinName ReplicateName RatioToSt: Concentration (fmol/ul) []
2 IEAIPQIDK GST-tag Standard_1 21.4513 40
3 IEAIPQIDK GST-tag Standard_2 6.2568 12.5
4 IEAIPQIDK GST-tag Standard_3 2.0417 5
5 IEAIPQIDK GST-tag Standard_4 0.8244 25
6 IEAIPQIDK GST-tag Standard_5 0.2809 1
7 IEAIPQIDK GST-tag Standard_6 0.1156 0.5
8 IEAIPQIDK GST-tag Standard_7 0.0819 0.25
._9_. IEAIPQIDK GST-tag Standard_8 0.0248 0.1
10 |IEAIPQIDK GST-tag FOXN1-GST | 0.7079)=B32*D10+C32 |
11
12 . .
13 Calibration Curve
14 45
15 0 y=18477x+05537
16 R =0.997' L.
17 - 35
= % 30
19 g
20 e 25
]
21 g 20
ol g
8 e
24 10
25 s p
26 /
27 0
28 o 5 10 15 20 25
29 Light-to-Heavy Ratio
30
31 Slope (m) Intercept (b)
32 | 1.847651372]  0.553724905) P
33 -
i < » | calibration /¥J M« i | a0
Edit | | B8 100%

This yields the value 1.86 as the concentration of FOXN1-GST within our sample. This concentration is in
units fmole/ul or nM, as this is the concentration of our calibrants used for the linear regression.

Since the purified FOXN1-GST reaction was resuspended in 100 pl total volume, we can state that there
are 189 femtomoles, or 1.13*10" molecules of FOXN1-GST within our sample.

Conclusion

This tutorial presented the advantages of different absolute abundance experimental setups and
demonstrated how to determine absolute abundances using an external calibration curve with an
internal standard heavy labeled peptide. This method provides accurate and precise absolute
measurements while minimizing the amount of valuable sample that has to be used during the
experiment.
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